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Description
TAPPS2 is a vector-based drawing program which was developed for planning and programming of
the UVR1611 and UVR16x2 controllers, the RSM610 control module, CAN-I/O45 and CAN-EZ2.
A configuration created with TAPPS2 can be converted into a data format that can be loaded to the
controller via the C.M.I. interface or the SD card of the UVR16x2 or the CAN-MTx2 CAN monitor. 
This manual only describes the necessary tools and procedures that are required for the graphical
creation of programming or hydraulic drawings.
Neither the principles of control technology nor a precise description of the individual function mod-
ules are covered by this manual. Please refer to the controller operating instructions for information
on function modules and their operation. 

Menu overview
File menu

• Creating a new file
• Opening an existing file
• Closing one or several files
• Saving one or several files
• Settings
• Page set-up, page view, print
• Importing of small graphics/images
• Importing function data
• Exporting function data and documentation
• Display of projects opened last

Edit menu

• Undo / Redo processing steps
• Cut / Copy / Paste / Paste CAN outputs as correspondingly converted 

CAN inputs / Delete selected objects
• Finding objects / Select all links of the selected object
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View menu

• Selection of display of page number, page grid and drawing grid

Object menu

• Arrange and align objects
• Line type and fill selection (global selection for the entire hydraulic draw-

ing and for drawing elements under programming)
• Font selection (global text formatting)

Extras menu

• Language selection
• Generating multilingual user defined designations

Help menu

• Display of the manual
• Information about TAPPS2 version

Language
A number of languages are available for selection. Select Extras \ Sprache (Extras\Language) and
click on the required language. TAPPS2 must be restarted for the language choice to come into ef-
fect.
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Tool bar
Frequently used actions can be started with a single mouse click on one of these icons. 
Part 1:

Part 2:

Part 3



9

Tool bar on the right

Selection mode for inserting objects, setting object parameters and creation of link lines

Node mode to create linking nodes

Editing mode to edit lines

Text mode to paste and edit texts

Draw polygons

Draw polylines

Draw rectangles

Creating, opening, saving files
Generating files
A new file can be generated with icon   from the tool bar or File / New…. The device type is defined
in the following window:

Opening existing files
An existing file (*.tdw) can be opened with icon  from the tool bar or File / Open…
Several files can be opened simultaneously. The opened files are displayed in the tab, at the top
above the drawing area. The drawing area which is currently visible is highlighted.
Example: Programming Solar X is currently displayed

Below this, you can switch between the hydraulic drawing and programming for the file displayed.
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With File / Files opened last, the required file can be selected from a list of the files most recently 
opened.
The associated controller type can be seen in the search tree when "Programming" is selected:

Saving files
The displayed file can be saved with  from the tool bar or File / Save.
If no name has been allocated to the file yet, a name will be allocated during the first save.
All opened files can be saved with  or File / Save all.

File / Save as... can be used to save an opened file with another name and edit it further.

Saving changes should also be carried out regularly during work in order to avoid a greater data
loss in the case of malfunctions (computer crash, power failure).
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Drawing Interface
View menu

The settings in the View menu can be used to structure the drawing
interface.

Page grid and page number: This distribution and numbering facilitates a clear print of the program.
You can thus take into consideration the limits of the individual pages while drawing the program and
prevent overlapping of objects across page margins.
Drawing grid: The drawing grid achieves a clear arrangement of objects and safe linking of the ob-
jects with the link lines. The objects and lines are aligned along the grid. Snapping the lines to the
linking points is facilitated by the automatic snap mode. 
The grid can also be switched on or off in the tool bar:

Zooming
Zooming with the scroll wheel
The scroll wheel enables fast and easy zooming whereby the position of the cursor is the fixed point
of the zoom.

Zooming with tools from the tool bar
Clicking on this symbol changes the cursor. You can now draw a rectangle across a group of
objects which are then zoomed to the size of the drawing interface.

If you click on one of these symbols, the drawing is zoomed in or out by a factor of 2. If a
drawing area is selected, the fixed point is the centre of the selected section; without selection, the
centre of the display area.

With the help of this tool, you can adjust the view to the size of the drawn program.
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Moving the drawing area
The drawing area can be moved in any direction by holding down the right mouse button.
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Importing function data (*.dat)

File / Import / Function data... allows function
data (*.dat files) to be pasted into a drawing.

Instructions for function data for UVR1611: In order to be able to import function data into TAPPS2, 
these must have been created with TAPPS V1.25 or higher. To be able to import older programs 
(*.eng/*.par) into TAPPS2, their function data (*.dat) must have been re-created with TAPPS 1.29.
Any default settings (function overview UVR1611, CAN data logging, device settings, etc.) are over-
written. The functions are embedded in the new drawing page by page. The sequence of functions
is sorted in numerical order.
When copying old TAPPS programs to an UVR 1611, it is therefore sensible to check the sequence.
With Sort functions… sequences can be changed in TAPPS 1.xx in order to optimize the arrangement
in TAPPS 2.
If the original program used signal transmissions and transfers, then they will now be displayed as
link lines.
Example of a function data import:
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Programming
Function data is created under "Programming", which is displayed under the file name.
Example:

Procedure of programming

1. Generating a new file  opening an existing file  for further editing.
2. Paste required elements (inputs/outputs, functions, etc.) into the drawing and position accord-

ingly.
3. Set input and output parameters.
4. If available: set network input and output parameters.
5. Link these elements graphically with lines.
6. Set function and message parameters.
7. Make settings (depending on controller type: device settings, sort functions and messages, cre-

ate function overview, adjust CAN data logging)
8. With Export from the logical circuit diagram, create the *.dat file (function data) for the controller.
9. Transfer the function data via interface (BL-NET or C.M.I.) or SD card to the controller.
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Function data objects
General information
Pasting obejcts into the drawing
Objects can be pasted into a drawing in two ways:
1. Directly from the search tree

Select the object

Move the cursor to the re-
quired position

Mouseclick

2. From the icon preview (with drag & drop)

Select the object

Mouse-click into the pre-
view field

Move the cursor to the re-
quired position while hold-
ing down the mouse
button

Release the mouse button

All objects, including functions, can be embedded in the drawing in the same way.

A double click on an object opens its parameter menu.
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Selecting
A simple click on the object in the drawing selects it. The object is then coloured red. It can now be
moved or aligned.
Example: Output

Selecting several objects
1. Selecting several objects in sequence whilst holding down the Shift key.
2. Dragging a frame whilst holding down the left mouse button can select an entire group of 

objects:

Moving objects
Selected objects or object groups can be moved with the mouse button held down or with the arrow
keys of the keyboard. With an active grid, the objects are aligned on the grid after moving them.

Undo / Redo
The tools  in the toolbar make it possible to undo or redo programming steps.
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Signal transfer and acceptance
A logical connection can thus be realised without having to draw the appropriate line of a link across
the entire page of the drawing.
Example:
Signal transfer

Window for entering the signal name following a double click

Overwriting the predefined signal name "Signal ID_xy" with the required name and complete with OK.

View of signal transfer after entry of the name

Signal acceptance

Entry window for signal name after double clicking

Selection of the saved name and completion with OK.

View after selecting the name
If multiple objects in the drawing are selected, the signal name for all selected signal objects is de-
fined in the dialogue.
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Moving object to the back or the front
This tool in the tool bar makes it possible to move objects in front or behind each other.
Example: A line crosses inputs and should be behind the inputs after drawing.
1. Select the line

2. Select the tool in the tool bar (Selected objects to the back)

3. Click on the line with the changed cursor (+)

4. The view has changed:

This action can also be carried out with  Object / Ar-
range / To the back.



19

Aligning objects in the drawing
With the help of these functions, is it possible to align objects according to specific criteria.
Example: Left adjust 3 inputs
1. Select the group of objects to be aligned (hold down Shift or with a selection frame)

The selection of the object that is align left (S3) is selected automatically. The group is aligned 
on this specially selected object.
If the alignment is to be on another object, then this object is selected with two individual 
mouse-clicks whilst holding down Shift.
Example: Alignment on sensor 2:

The sensor S2 is now highlighted.
2. Selection of the alignment method (in this example: "Align left on the object selected last") with 

a mouse-click

3. The sensors were aligned on sensor S2:

This action can also be carried out with "Object / Arrange / Align Left".
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Function data objects for UVR1611
Application of user-defined designations

A click on this field calls up manage-
ment of user-defined designations.
Up to 16 designations can be de-
fined, which can be allocated to in-
puts, outputs, messages or functions
as required.

These can be selected from the list
following the definition of the re-
quired designations.

Example: Management of user-defined designations

The designation must not exceed 12 charac-
ters and must not contain special characters
or umlauts.
However, for functions displayed on the
UVR1611 only 9 of the maximum 12 possible
characters can be displayed.

Double designations
If a designation is selected for an object that has already
been allocated before, a warning triangle will be dis-
played.
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Outputs
A double click on the object takes you to the parameter menu. The drawing object will be initially
deemed to be unused. After assigning an output number, the standard parameters are offered for
selection.
Example: Output 1, Solar pump 1

OK saves the settings of all outputs and
the drawing object is assigned to the se-
lected output.

OK, without allocation saves the set-
tings of all outputs.

The Links comply with the Output status
in the controller.
Here, all output links are displayed with
their functions.

Likewise, the above also applies to output 14 (data link), analogue outputs 15 and 16, as well as the
mixer output pairs 3/4, 8/9, 10/11 and 12/13.
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Inputs
As with all drawing objects, a double click takes you to the parameter menu.
Example: Input 1 collector sensor

Sensor status
Setting parameters following a double click.
Example: Display of the sensor status for sensor input 1
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Network outputs
Setting parameters following a double click.
Under Controller, the network settings of the controller are defined (node number, network enable,
auto operation).
The link can be seen under Parameter.
Under the 3rd tab, the Transmission conditions are defined.
After setting parameters, the network output is displayed as follows:

Network inputs
Setting parameters following a double click.
In the tab "Controller", the network settings of the controller are defined (node number, network re-
lease, auto operating).
In "Parameter", the source for the network input is defined.
In the 3rd tab, the "Timeouts" are defined.
After parameterisation, the network output is displayed as follows:

Network status
Example: Network status display for network input analogue 1



24

Functions
Setting parameters following a double click.
Example: Solar function

The input variables highlighted in purple are mandatory variables that must be linked without fail.
Setting parameters following a double click on the drawing object is not possible immediately unless
these links have been made. If this is attempted anyhow, an error message will appear which will
have to be confirmed with OK.
"Mandatory!" will appear in the parameters of the
respective input variables that were not linked.
The input variables highlighted in green can be
used but do not have to be.

Example: Heating circuit controller
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Function data objects for devices with x2 technology
(UVR16x2, RSM610, UVR610, CAN-I/O45, CAN-BC2, CAN-EZ2)

Managing designations, creating user defined designations

Clicking on this button calls up the window
for managing and selecting all designations.

Firstly, the program's default designations are
shown.
The designations are divided into different
groups. A search function makes it easier to
find the right one. You only need to enter part of
the term you are looking for.
Designations that are not used in the program-
ming are shown in green.

If the required designation is not found, click-
ing on the plus icon immediately inserts the
term as a user defined designation.

Clicking on "OK" applies this newly defined
designation for the object.
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A new designation can also be entered directly in the 
list of user defined designations.

Clicking on "OK" allocates the designation to the object, whereas clicking on "OK, without allocation"
only saves the new designation in the list without applying the designation to the object.

All recently used user defined designations
(including those from earlier programs) are
listed at the bottom of the window and can
be selected directly or using the search
function.

For direct selection, click on the designation (becomes highlighted) and then "OK".
As soon as a designation from the list of recently used designations is allocated to an object, it is
also shown in the list of user defined designations in the current program.
Up to 100 designations can be defined (250 for UVR16x2, UVR610, CAN-EZ3 and CAN-MTx2) with a
maximum of 24 characters, which can be allocated to all function data objects as required.
Previously defined designations can be edited (changed) directly in the list of user defined designa-
tions. The modified designation appears in addition to the original designation in the list of recently
used designations.
Entries in the list of recently used designations can be deleted with the "Delete" key. The program's
default designations cannot be edited or deleted.

Double designations

If a designation that has already been as-
signed is selected for on object, the areas
"Designation" and "Des. index" will be shad-
ed in yellow.
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Global user defined designations (multilingual)
Using the "global user defined designations", it is possible to create translations of these designa-
tions and apply them in the required language. 
These designations include the "recently used user defined designations".
For this purpose, a translation memory is created, which is saved on the user's PC irrespective of the
relevant program, and which can be called up by TAPPS2.
The example below explains how to create a translation memory in the available program languages.

Eight designations are currently saved. After ticking "Use multilingual user defined designations",
click on "Export" to create a csv file for the translator.

Here, the language for the csv file is selected along with
whether previously translated designations should be included
in the csv file as well.
If the entire translation memory (all languages with all existing
translations) is exported to the csv file, the translation memory
can be imported into TAPPS2 on other computers.

Click on "OK" and then specify the folder and file name for the
csv file.
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Example of a csv file after export and translation:
The programmer can enter explanatory
comments on the terms for the translator
in the csv file.
The translator puts the translated designa-
tions in the relevant language column. In
this example, the csv file was created for
German (column "de" = German).

After translation, this table can be reimported into TAPPS2.
Tick these boxes as required to insert the translation and/or the com-
ments.
If comments have been included once, in future they will automatically
be included (even in other languages) when exporting to the csv file.
Press "OK" to finish.

When exporting an "entire translation memory", you have to decide
whether to combine the file with the existing translations in the transla-
tion memory, or whether to completely replace the translation memory.
Press "OK" to finish.
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In the "User defined designations" menu, you can see whether all the designations in the translation 
memory are translated (= 100 %).

Applying the translated designations
Example: In a program that has been created in English, the user defined designations also need to
be shown in German on the x2 device for an German-speaking user. 
Requirement: All user defined designations within the program must be translated.

The original language was English. Before
the change, English user defined designa-
tions are therefore shown. The language for
the designations needs to be changed to
German.
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The language has to be changed for this application scenario.

If not all designations in the list of "User defined designations" are translated, the language cannot 
be changed and the following message appears:

Once the language has been changed from English to German, designations are shown in German.

A dat-file has to be generated for the x2 device for every language so that the right user defined des-
ignations can be shown on the device.
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Creation of translations for non-defined languages
Procedure if the language of the user defined names has not yet been defined:
1. Open the program with TAPPS2 version ≥1.11.
2. Set the language to English for the user defined designations in the menu File/Settings/Device 

settings.

3. Add the designations to the translation memory (menu "Extras/Global user defined designa-
tions").

If the language has not yet been defined in the device settings (language "undefined"), the follow-
ing message appears:

4. Click "Export" to create a csv file for the translator.
5. After translation, import the csv file.
6. In future, the "old" user defined designations can now also be used in other programs (see previ-

ous chapter "Applying the translated designations").
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Outputs
A double click on the object takes you to the parameter menu. The drawing object will be initially
deemed to be unused. After assigning an output number, parameters are displayed for selection.
Example: Output 1, Solar pump

Nach Auswahl der Ausgangsnummer
muss der Typ festgelegt werden. 
Danach wird die Bezeichnung aus-
gewählt und werden alle weiteren Ein-
stellungen vorgenommen.

OK saves the settings of all outputs and
the drawing object is assigned to the se-
lected output.
OK, without allocation saves the set-
tings of all outputs.

Links

Here, all connected links of the output
are displayed with their functions.

Blocking protection
A time for all outputs that are to receive blocking protection (see controller manuals) can be entered
here.
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Inputs
Setting parameters following a double click.
Example: Input 1 Sensor collector 1

After selecting the input number, type
and variable must be defined. 
The designation is then selected and
all additional settings are made.

OK saves the settings of all inputs and
the drawing object is assigned to the
selected input.

Save the settings of all inputs with OK, 
without allocation.
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CAN outputs
Setting parameters following a double click
Under the Controller tab, the CAN network settings of the controller are defined (node number, BUS
rate, designation).
The link can be seen under Parameter. The designation of the CAN output and the transmission con-
dition are defined here.
Example: Linking of analogue CAN output analogue 1 with the actual value of input 1

After selecting the type and the
CAN output number, the desig-
nation is selected and all addi-
tional settings are made.

After setting parameters, the CAN output is displayed as follows:
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CAN inputs
Setting parameters following a double click
Under the Controller tab, the CAN network settings of the controller are defined (node number, BUS
rate, designation).
In Parameter, the source and the time-out for the CAN input are defined. 
Example: Analogue CAN input analogue 1 of CAN Bus device with node number 2 and its CAN output
1

After selecting the type and the
CAN input number, the designa-
tion is selected and all addition-
al settings are made.

With entry of the User def. vari-
able User def., the unit, a sensor
correction and user-defined
monitoring of the sensor value
can be defined.

After setting parameters, the CAN input is displayed as follows:
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DL outputs
Setting parameters following a double click
Analogue as well as digital values can be transmitted via DL output.
The link can be seen under Parameter. The designation of the DL output is defined here.
Example: Linking the DL output 1 with the result of the OR function for target address 1 index 1

After selecting the DL output num-
ber, the designation is selected and
all additional settings are made.

After setting parameters, the DL output is displayed as follows:
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DL inputs
Setting parameters following a double click
In Parameter, the type and the source of the DL input are defined. 
Example: Analogue DL input 1 of DL sensor with address 1 and its index 1

After selecting the DL input num-
ber, the designation is selected and
all additional settings are made.

With entry of the User def. variable,
the unit, a sensor correction and
user-defined monitoring of the sen-
sor value can be defined.

After setting parameters, the DL input is displayed as follows:
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Fixed values
Setting parameters following a double click
Example: Fixed value 1 with designation "Nominal temperature 1", with setting limits

After selecting the fixed value
number, type and function size
must be defined. Then the desig-
nation can be entered and all addi-
tional settings made.

System values
Setting parameters following a double click

Example: System value time / hour

The required value is defined after se-
lecting the group.
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Functions
Setting parameters following a double click
Example: Solar function

The input variables highlighted in purple are mandatory variables that must be linked without fail.
Setting parameters following a double click on the drawing object is not possible immediately unless
these links have been linked. If this is attempted anyhow, an error message will first appear which
can be confirmed with OK.
Example: Solar function

"Mandatory!" will appear in the pa-
rameters of the respective input var-
iables that were not linked.

The input variables highlighted in green can be used but do not have to be.
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Example: Heating circuit controller with all input and output variables

Display / hide input and output variables

The invisible input and output variables can
be displayed by scrolling or moving the scroll
bar.

If the check mark at Display pin is removed,
these input or output variables will no longer
be displayed in the drawing area. 
It makes the view of numerous functions
clearer if these variables are not used.
The check mark cannot be removed in the
case of mandatory variables (highlighted in
purple) or linked variables.
With these buttons, all the pins can be hidden
("Cancel selection") or displayed ("Select
all"). The pins of mandatory variables or
those that are already connected are exclud-
ed from these actions.

A selection for the input and output variables displayed immediately was made at the factory to
make the display of functions clearer. These hidden variables can be re-displayed at any time with
Display pin.
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Example: Unused input and output variables were hidden.

Setting the parameters

The hidden parameters can be
displayed by scrolling or mov-
ing the scroll bar.

Expanding the window
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After linking an input, output, DL input or CAN input with a function, the information of the variables 
to be transmitted to the function can be defined in the input variables of the function.
Example: Analogue function, DL input analogue

• Measurement – the value captured by the sensor
• RAS mode – the following analogue values are issue depending on the switch position on the 

room sensor (RAS):
Automatic 0
Normal 1
Setback 2
Standby 3

• Sensor error – digital value, ON with sensor errors
• Network error – digital value, ON there has been a time-out (= error)
Input variables deviating from the factory settings will be displayed in blue.
Example: The Sensor error variable of the sensor was selected.
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Output variables

The output variables highlighted in
black can be linked only with input var-
iables of other functions or CAN and DL
outputs.
The output variables highlighted in blue
can be linked with outputs. But links to
input variables of other functions or
CAN and DL outputs are also permit-
ted.

An error message is displayed if a forbidden link is made.
Example:
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CORA devices
Shown only when programming CORA devices (e.g. CAN-EZ3)
The "CORA devices" item is located at the end of the selection tree.

Example: EHS immersion heater
Programming after double clicking.

Number of the CORA device in the program

Output variables (sent by the immersion heat-
er)

x2 wireless ID of the CORA device

The drawing objects for CORA devices are also designed for input variables (= values sent to the
CORA device), but there is no use for them as yet.
More detailed information on CORA devices and how they work, as well as general information about
the wireless system, can be found in the instructions for the respective devices.
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Links
Direct links between 2 objects
1. If you hold the cursor over a link, it will turn into a green square and the cursor turns into a pencil.

2. A mouse-click changes the shape to a green circle.

3. Now drag the cursor to the required target point to generate a line.

If the target point is not on the same level, the line is adjusted at right angles.
4. A click on the target point fixes the line and thus the link in place.

The green, circular link points show that a link exists.

The direction in which the cursor is dragged from the starting point determines the course of the link 
line:
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A mouse-click whilst dragging of the line generates a corner point. Lines can thus be taken around 
other objects and thus do not disturb the view of the object.
Example:

Changing the line shape
As long as the link is not completed, the line shape can be changed by pressing the tab key:

Original line (the line was dragged away from the linking point
horizontally)

Line after the pressing the tab key once

Direct, slanted line after pressing the tab key twice
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Editing lines
Moving corner points
1. Place the cursor over the required corner point which changes its shape.

2. With the mouse button held down, the corner point can now be moved.

Changing a line
If you place the cursor directly over a point on the line, its shape will turn into a "+" sign. 

With the left mouse button held down, the line can now be dragged to this point.
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Moving a line
The shape of the cursor changes if you place the cursor over a line whilst holding down Alt.

With the left-hand mouse button held down, the line can now be dragged in parallel.

Branches
Example: Heating demand; the set value demand is to be linked with the set temperature shutdown
by means of a branch.

The branch can be generated in two ways:
1. Press Ctrl on the keyboard and take the cursor to the required node point. The 

node point is displayed as a green square; the cursor turns into a "pencil".
2. Click on the Node mode in the right-hand tool bar.

The cursor is taken to the required node point. The node point is displayed as a 
green square; the cursor turns into a "pencil".
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After that, both methods are identical:

A mouse-click changes the shape to a green circle.

Now drag the cursor to the required target point to generate a line.

A click on the target point fixes the line and thus the link in place.

Deleting objects and lines
1. Select an object, object group or line 
2. Delete with the help of Del or with the Edit / Delete parameter.

Command „Select links“
The commands "Select links" and "Edit / Select links" (shortcut: Ctrl+Shift+F) select all links of the
currently selected drawing object. In addition, if signal transfer is selected, all associated signal ac-
ceptances are selected and vice versa.



50

Invalid links
If links are created that are not permitted, an error message will be displayed when attempting to set
parameters.
Setting parameters can continue if you click on OK in spite of the message.
We recommend removing the error though before continuing with setting parameters.
Function data for the controller can be generated only after all errors have been removed.

Network input – output
An output cannot be switched directly from a digital network input. This requires the appropriate log-
ic or analogue function.

INCORRECT:

CORRECT:
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Linking two output variables
Output variables may not be linked.

For this, identical outputs are linked with the logical operator OR (if one switches to ON, so do all the
rest).

INCORRECT:

CORRECT:
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Single network output on multiple functions
Every network output must appear only once in the drawing.
If the value of a network output is formed with multiple functions, then this must be realised accord-
ingly with logic or analogue functions.

INCORRECT:

CORRECT:
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Several network inputs refer to one network output of another CAN-Bus device
For every parameter which is called up from the network, only one network input may be defined on
a single device.
But it is possible to use several symbols for the same network input in the drawing.

INCORRECT:

CORRECT:
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x2 devices only
If a CAN input with identical parameters is defined for the node number and the output number (of
the sender) of an existing CAN input, then this error is highlighted with a yellow background.
The same error display is issued for a DL input with the same address and index of an existing DL
input.
Example: CAN input

If this error is not corrected and the CAN input is opened again, an error message will be displayed:

If the error is still not corrected, exporting faulty function data will be prevented and the error log will
highlight the cause:
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Texts
Text insertions
1. A mouse-click on the text symbol  in the right-hand tool bar activates text mode.

The cursor in the diagram changes its shape to a "pencil".

2. Positioning the text field  the drawing with a mouse-click.

3. Entry of the text 

4. Clicking in a free drawing area stops the entry.

5. The cursor is still a "pencil" and additional text can therefore be entered. Only when Selection 
mode (cursor: ) in the tool bar is selected will the text mode terminate.

6. If necessary, the text format (in Selection mode) can now be changed with a double click on the 
text.
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Subsequent editing of the text is possible with shift  + double click on the text or by selecting 
the tool  (insert Text) and a mouse-click on the text.
Texts can be moved, selected and aligned like all others objects.

Global text formatting
By selecting Object / Font, the font can be formatted for all subsequently inserted texts if no text ob-
ject in the drawing is selected.
If a text object is selected, the formatting can be changed for this object.GG

Graphics/Images
Small graphics can be placed in the hydraulic sys-
tem drawing via File > Import > Image.
Images must be in PNG format and should not
exceed a file size of 100 kB.
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Copying objects and texts
Before copying, the required object or the required object group must be selected.
Copying can be done in three different ways:
1. Using the symbols in the top tool bar:

2. Using shortcuts:
Copy: Ctrl + c
Paste: Ctrl + v

3. Using the commands under Edit:

Copying within a drawing
An example explains the individual steps.
Example: Copying an output

1. Selecting the object
2. Applying one of the three copying methods
3. Trigger the associated Paste, the object is now indi-

cated at the cursor. 

4. A mouse-click fixes the position of the object. Pasting several times is also possible.

If functions are copied, then the new functions will receive numbers that continue from the last func-
tion.

All copied objects adopt the parameters of the original object.

Exception: Functions in which involved functions are listed (e.g. solar priority).
If only the function is copied, then the involved functions of the copied function will be maintained.
If at least one of the involved functions is also copied, then the involved functions also copied will
be listed as new functions but with the same designation. The functions that are not also copied
return to "not selected". Their parameters must subsequently be set again.
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Copying between two drawings
If inputs, outputs and/or fixed values are copied between two drawings, the following window ap-
pears.

This is used to determine the number with which copied inputs/outputs etc. are to be inserted in the
programming. Objects which have already been allocated can be rearranged in the "Allocated" col-
umn using drag & drop.
When copying between two drawings, a check is performed to determine whether the elements being
copied are already in use elsewhere in the target file.

Clicking "Next" starts conflict resolution for the first object type (e.g. inputs).

The entries on the left are those which could not be allocated. It is now possible to use drag & drop
to insert objects anywhere in the target drawing (= right-hand side). Dragging onto existing entries
overwrites these entries. The number of unallocated entries is shown in red at the top, next to the
object type (e.g. inputs).
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When a value in the target drawing is being replaced, an arrow is shown in the right-hand list.

In the example, the arrow indicates that the name and parameter settings of the left-hand value are
overwriting those of the right-hand value. Clicking on the arrow reverses this function. Click "Contin-
ue" to display the conflict resolution task for the next value type.
After completing the last conflict resolution task, a summary is shown.

If there are no further conflicts, the summary looks like the one shown above. Select "Finish" to ac-
cept the changes and exit conflict resolution. The copied objects can now be inserted by left-clicking.
If any unresolved conflicts remain, these are shown in the last window. In this case, selecting "Finish"
will discard the values in the list and insert unused values instead.

Conflicts may also arise when copying objects between drawings on different appliances.
Example: The source file (UVR16x2 programming) has more inputs assigned to it than the target file
(RSM610 programming) permits (7 inputs programmed, RSM610 only has 6 inputs).

User defined designations are transferred automatically. However, if the maximum number of user
defined designations in the target file is reached, this will also result in a conflict page being dis-
played.
You may also be prevented from inserting anything at all due to differences between the devices (in
which case neither a dialogue box nor an error message is displayed). This can occur, for example,
when inserting inputs into the program for a CAN-BC2.
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Paste as CAN-Inputs
If there are CAN outputs among the copied objects, they can be converted to corresponding CAN in-
puts when pasting. You can do this with the command "Edit > Paste as CAN inputs" (shortcut:
Ctrl+Alt+V); the CAN node numbers, output numbers and descriptions are also adopted.
If CAN inputs are pasted in this way, none of the other elements that you initially copied are inserted.
The CAN inputs are grouped according to analogue and digital inputs, and sorted by input number.

Deleting objects
Highlighted objects are deleted if the Del key is pressed, or via Edit > Delete.

If an object (input, output, CAN input, etc.) is deleted, its parameters nevertheless continue to be 
stored in the programming.
If an object is deleted with Shift+Del, the object (if applicable, e.g. input) is deleted and its program-
ming set to unused.
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Cutting objects
The menu command Edit / Cutting or the shortcut Ctrl + x can be used to cut out a selected object
or selected object group. They are thus deleted from the drawing but remain in the clipboard so they
can be pasted again.
With the Paste command or the shortcut Ctrl + v, this object can be pasted in the same or any other
drawing of the same controller type. Pasting several times is also possible.
As with Copy, the same conditions for maintaining parameter settings apply.
If functions are cut, the subsequent numbered functions move up in sequence. 
The cut function that was pasted into a drawing will receive the number following that of the last
function.

Inserting simple drawing objects
Polygons, polylines and rectangles can be inserted in the drawing area:
1. Click one of the drawing icons in the right-hand toolbar to activate drawing mode.

In the drawing, the cursor changes to a "pencil".
2. Click to position the drawing object in the drawing. 
3. Additional editing (line type/fill) is carried out as in the "hydraulic" drawing area and is 

described in chapter "Hydraulics".

Finding objects
The find function can be used, for example, in extensive programming to search for elements using
their full name or type, or just parts thereof. 
Example: Find "Solar pump"

Result: The output with the designation
"Solar pump" appears 10 times in the
drawing. Clicking "Find and select" high-
lights the 10 solar pumps in the drawing
in red so they can be found easily.
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Personalised libraries
It is possible to create personalised libraries.

At the end of the selections, there is an entry "Personalised libraries".
Right-clicking on this opens a context menu.
•Add a new Personalised Library
•Select the directory in which Personalised Libraries are saved
•Update Personalised Libraries if they have changed
•Import and export Personalised Libraries

Clicking on "Add new library..." opens a dialogue box where the library can be given a name.
To add an entry to the library, select any number of objects in the draw-
ing. Then right-click on the name of the relevant personalised library in
the list and select "Add from drawing". The naming prompt appears
again.
To paste the entry into a drawing, select it in the same way as any other
object and then position it in the drawing.
The parameter settings of all objects added to the library are adopted.
Personalised libraries affect all drawings and files.

An entry can be changed by taking it from the library and placing it
in the drawing, editing it there, highlighting it and then replacing it
in the library with the new version (right-click > "Replace from draw-
ing").

Personalised libraries can be imported and exported as .lib files. Right clicking on "Personalised li-
braries" and "Export" opens a pop-up window, where you can choose which personalised libraries to
export. You then select a folder in which to save the selected personalised library as a separate file.
If you click on "Import", you can follow the same principle to import .lib files.
You can also right-click directly on a personalised library to export this file only.

Personalised libraries are saved as .lib files under Documents\Technische Alternative\Tapps2\librar-
ies. This directory can be amended (right-click > "Select directory").
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Shared libraries
Libraries can be shared between multiple users.
There is a separate additional entry for this, "Shared libraries".
To be able to use "Shared libraries", first of all a directory needs to be spec-
ified (right-click > "Select directory...").

Note that all computers with the same network protocol (SMB or NFS) can access the "Shared librar-
ies" directory on the fileserver.
TAPPS2 automatically combines changes from multiple users of the same library.
If the same element is being edited simultaneously by multiple users outside the library and is then
replaced in the library, however, it is not possible to combine these changes.
If changes have been made to a library outside the program, e.g. by another user, the library is auto-
matically reloaded before your own changes are made.
A library can also be reloaded manually with right-click > "Refresh".
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Settings
In the Settings menu, the following general settings can be made for the controller:

•Device settings
•Sort functions and messages
•Configure CAN data logging

Device settings
Depending on controller type, the default settings for the controller, the network settings and the wel-
come screen can be set here.
 UVR1611 Devices with x2 technology (e.g. UVR16x2)
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Sort functions and messages

The sequence of the functions as displayed in the controller can
be changed in this menu.
This will also change the function number in TAPPS2

Only for UVR1611:
The sequence of the messages as displayed in the controller
can be changed in this menu.
This will also change the message number in TAPPS2.
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Sorting CORA devices
In this menu, the order of the functions as they are displayed in
the controller can be changed.
This also changes the number of the function in TAPPS2.

Sorting inputs/outputs
In this menu, the assignment of inputs and out-
puts can be changed.
Inputs/outputs can be assigned to empty
spaces or swapped with each other. These
changes apply to all existing drawing objects.
When rearranging CAN outputs, the corre-
sponding CAN input at the receiver must be ad-
justed.
Likewise, an existing visualisation (TA-Desig-
ner) must be updated after rearranging inputs/
outputs. If a .dat file is exchanged there, the
TA-Designer does not recognise rearranged in-
puts/outputs. Manual adjustments have to be
made.
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Function overview UVR1611
The function overview is a menu screen in the controller that serves to display only the information
that is important to the customer.
The parameters displayed there can also be allocated with an authorisation for changing set values.

Procedure for inserting a display parameter into the function overview:
1. Select the parameter that is to be displayed in the function overview from the list of available 

parameters.
2. Select the position above which the display parameter is to be inserted from the list of function 

overview parameters.
3. Select the authorisation for changing the parameter.
4. Insert the selected display parameter in the function overview.

A click with the right-hand mouse button on a selected parameter opens a se-
lection menu where the authorisation level can be changed.

Elements are deleted in the function overview within the same manner:

Function overview UVR16x2
The function overview for UVR16x2 is created with the TA-Designer program.
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CAN data logging
x2 devices
Minimum versions:
C.M.I. 1.25
Winsol 2.06
Up to 64 analogue and 64 digital values can be defined for CAN datalogging for x2 devices.
The left column shows all the available parameters that can be added to the right column. The right
column has the tabs "Analogue values" and "Digital values". Therefore, when new logging values are
inserted, it is important to check whether the value is an analogue value (numerical value) or a digital
value (ON/OFF).
Procedure for linking a parameter into data logging:
There are 2 options:
1. Selection of the value to be logged from Available parameters on the left and dragging it to the 

logging value where it should be displayed (drag & drop).
Example: The set flow temperature for heating circuit 1 is to be logged as analogue value 8.

It is possible to select several values simultaneously using the Shift or Ctrl key.
To remove values, select them and press the "Delete" key on the PC key-
board to set them to "unused".
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2. Using the arrows to overwrite or delete the entries in the list on the right
a) Select the data type in the right column (analogue/digital).
b) Highlight the position where a new parameter is to be inserted into the list.
c) Select the parameter which is to be incorporated from the list of "Available parameters".
d) Insert the selected parameter into the list on the right by clicking =>. After the parameter 

has been inserted, the following parameter is automatically selected.

Example: Inserting the heating circuit set flow temperature into "Analogue values" as "Analogue 8"

It is possible to select several values simultaneously using the Shift or Ctrl key.
Selected values can be reset to "unused" by clicking the back arrow (<=).

Datalogging on the SD card of the UVR16x2
Minimum controller version: V1.24
Under the "General" tab, you can define whether the logging values are stored on the controller SD
card and if so, at what intervals.

Example: datalogging on the controller SD card has
been selected. The interval time is 30 seconds.
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UVR1611
For CAN data logging, two data records can be freely defined. One data record comprises 16 ana-
logue and 13 digital parameters.
The left-hand column shows all available parameters that can be added to the data record in the
right-hand column. In this respect the following details must be observed:
Speed stages of outputs 1, 2, 6 and 7:
To record the speed stage of an output, the digital parameter with the same number must be allocat-
ed to the output in data record 1. 
Heat meter functions:
The output variables of the heat meter functions are, according to the sequence in the function list,
automatically linked to the two data records (heat meters 1 and 2 in data record 1, heat meters 3 and
4 in data record 2). Although Winsol can log the output variables in a data record, they are displayed
with the incorrect unit (°C). When correspondingly high values are reached, these can no longer be
displayed correctly in the diagram and are no longer meaningful.
Procedure for linking a parameter into data logging:
There are 2 options:
1. Selection of the value to be logged from Available parameters on the left and dragging it to the 

logging value where it should be displayed.
Example: The set flow temperature of heating circuit 1 should be logged as analogue value 7 of 
data record 1

To remove a value from the data record, select it and use Del on the PC to set it to unused.
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2. Use of the arrows to overwrite or delete the entry in the data record
a) Select the data record to be defined from the right-hand column.
b) Select the position in which a new parameter is to be inserted in the data record.
c) Select the parameter that is to be inserted in the data record from the list of available parame-

ters.
d) Use => to insert the selected parameter into the data record. After insertion of the parameter, the 

data record automatically selects the following parameter.

Example: Inserting the set flow temperature of heating circuit in data record 1 as Analogue 7

The back arrow (<=) can be used to reset a selected value in the data record to unused.
The Master node is the node number of the C.M.I. or BL-NET.
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Simulation
As of version 1.16, function data can be simulated directly in TAPPS2.

Clicking the "Start simulation" button (on the taskbar at the top) simulates the current
programming.

Example

1. Value of the sensor input. Click on the numerical value to change it.
2. Digital input variable. The status of digital values is displayed here (e.g. On/Off).
3. Status of the output variable. The output variable of the function is displayed. It cannot be

changed manually as it reflects the actual result of the function calculations.
4. Status of the output. The status of the output is displayed.
The programming cannot be changed once the simulation has been started. If, for example, a new
function needs to be created, you first have to exit the simulation. This does not apply to simulation
values of input variables, fixed values, etc.
Double-click on a function to view the values of all output variables, even if their pins are hidden in
the programming:

Parameters of functions, fixed values, inputs and outputs can be changed, but you have to exit the
simulation to apply the changes.

Values that do not have enough space to be displayed are added to the corresponding drawing ob-
ject:

The x2 simulator (minimum version 1.38) must be installed on the PC. (ta.co.at/download/soft-
ware/)

https://www.ta.co.at/download/software/
https://www.ta.co.at/download/software/
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Changing values
During the simulation, values such as sensor inputs and similar can be adjusted to simulate the con-
trol effect of the programming under various circumstances. In addition to sensor inputs, input vari-
ables, etc., values appear that you can click on.
Analogue values
Example: Sensor input

The value can be changed with the arrow buttons, scroll wheel or by entering numbers directly.
The input variable to which the sensor input is connected adopts this value:

Digital values
Example: Digital fixed value

If you click on the field with the status of the digital value (e.g.: "Off"), it is changed (e.g. to "On"):

Pulse
Example: Resetting a heat meter using a fixed pulse value

The field changes briefly to the pulse that is issued and then returns to the normal display.

Pulse inputs for e.g. wind speed are set in the same way as analogue inputs.
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Temporal mean value calculation
In simulations, temporal mean value calculation is disabled. This means:
• No temporal mean value calculation of the outside temperature in heating circuit control, cooling 

circuit control or individual room control.
• Analogue function, filter mode: simulation with "filtering time" = 0.
• No temporal mean value calculation for inputs.

CAN bus simulation
CAN bus inputs and outputs can also be simulated for all devices.
For this purpose, multiple programming functions (up to 62) are opened in the same TAPPPS2 win-
dow.

The CAN bus inputs and outputs are created in the usual way in the respective programming func-
tions. If the node numbers and output numbers match, the program automatically recognises the re-
lationship.

The node number of the device which sent the value to the CAN bus (on the left in the example) is
changed via File > Settings > Device Settings > CAN Bus.
If the simulation is now activated in both projects with , the value is synchronised between them.

The simulation of the CAN bus inputs and outputs does not take into account their send conditions.

CAN output from node 32 and output 
number 11

The value is read in again as a CAN input 
(node 32, output number 11)
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Date/time/Mean value calculation
The date and time can either be taken from the PC or set by the user.
If the simulation is active, a bar appears at the bottom:

In this example, the values are greyed out and cannot be selected. The date and time are therefore
taken from the PC.
Click on the clock symbol  to change the date and time and use them for the simulation.
Changing the time only affects functionalities that actually relate to the time. Values such as remain-
ing runtimes or timers are not influenced by the time.

Simulate surplus power
Only available for programming CAN energy meters!
If the simulation of a CAN-EZ3 is started, the surplus power can be simulated in the bar at the bottom.

After entering a surplus power value, the system value "Total real power" is further corrected. An ex-
isting energy manager + output control will attempt to consume the available surplus power (the in-
put variable set value of the energy manager can influence this). Therefore, if a surplus power value
is entered, it is to be expected that the system value "Total real power" will not correspond to the in-
put.
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Buttons
Many functions have buttons which can be pressed on the controller itself in the menu or in the func-
tion overview, e.g. "Start single charging" for the DHW demand function.
As of version 1.19, these buttons can also be actuated in simulation mode.
Example: Start single charging

A single click triggers the charging process.

Example: Meter reset

A single click resets the meter.

Example: Blind control

The "Open blind" and "Close blind" buttons are actuated by holding down the mouse button. The other
buttons are clicked once.
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Generating function data and documentation
Function data

With File / Export / Function data or File / Export /
Documentation, the function data (*.dat file) and
the documentation (*.txt file) can be generated.

If the programming is faulty, an error log listing the errors is generated before generating the function
data.
Function data and the documentation can be generated only after all errors have been removed.
Example of an error log:
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Before saving the function data, the minimum requirements for the operating system and the serial 
number must be checked and observed in accordance with the specification of the controller type.
Example UVR16x2:
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Documentation

Unused parameters can be filtered out before
saving the documentation.

Example UVR16x2

The documentation can be created in different file formats as required:
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Exporting a screenshot
This functionality makes it possible to export the visible section of the drawing area as a PNG or
JPEG file.

The required image size is entered to fit the display screen. The
height/width proportions are kept the same.
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Drawing function under „Hydraulics“
A hydraulic drawing is created under "Hydraulics", which is displayed under the file name.
Example:

Navigating within the drawing area (selecting, zooming, moving, bringing forward/backward, align-
ing, copying) and dealing with links are exactly the same as under "Programming" and are described
there. 
Note on lines:
If the Shift key is pressed before a diagonal line is completed, it changes to an orthogonal line (hor-
izontal or vertical).

Libraries
Standard libraries

The program provides various hydraulic icons in a standard library.
These icons are available on the left-hand side in a search tree. 
The selected element is displayed in the preview window above.
Icons are inserted into the drawing in the same way as objects are in-
serted in the programming area.
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Personalised libraries in hydraulic drawings
It is also possible to create personalised libraries with personally designed el-
ements. In the example, the personalised library "Test" and 3 personalised ele-
ments have already been created. The selected element is displayed in the
preview window above.

Editing is possible by right-clicking the relevant element:

Create a new library

Create elements or edit the library

Edit elements

Personalised libraries and elements can also be created and edited using the
tool icons in the library area.

Shared libraries in hydraulic drawings
The principles of shared libraries are described on page 63.
While a hydraulic symbol is being edited in a library, that library is unavailable to all other users.
During this period, no other users can make changes to the library.
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Creating and editing library elements
The standard library elements cannot be changed in the library. Standard elements in the drawing
area can be changed using the Icon editor.

Personalised library elements can only be set up once a personalised
library has been created.

The new element can then be set up. This must firstly be given a name,
then the Icon editor opens.

Icon editor
The "Icon editor" opens when new personalised elements are created or an element in the drawing
area is double clicked.
Example – "Solid fuel boiler":

If you want to edit a standard element and save it as a personalised element, right-click the standard
icon in the list to duplicate it.
Alternatively, you can first position the standard element and then double-click on it to open the edi-
tor shown above. An edited icon can be saved to a personalised library under Editor  Save as + Exit.
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Selection mode
Single, selected elements can be brought forward or backward, rotated, flipped or
aligned using the toolbar at the top.

Further drawing elements (lines, rectangles, circles, arcs, ellipses, texts) can also be inserted using
the toolbar on the right.

In selection mode, double clicking a line or an area element (e.g. circle) enables you to change the 
type, colour and shape of the line or the fill colour of the area element:
Example: Circle in the boiler
The element that has been clicked is highlighted (red)
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Editor mode
In editor mode, the shape of individual elements of the icon can be edited.

Example: Solid fuel boiler
Click the rectangle in editor mode. Now the shape
can be changed by dragging the displayed marker
points.

"Pins" are a special feature. These are connecting points for lines, which enable a pre-
cise link to the elements.

Example: Extending the cylinder icon using 2 pins

This amended icon could now be copied and saved as a new library element in a personalised library.
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Selected elements can be brought forward or backward, rotated, flipped or aligned using the toolbar 
at the top.

Texts are inserted in the same way as described under "Programming".

Every change or new action can be reversed or restored using "Undo" or "Redo".

Every change in the Icon editor must be completed with the tick  . 

If the changes should not be saved, click  .

Duplicating elements
Elements can be duplicated by clicking the right mouse button. Ele-
ments from standard libraries and personalised libraries can be dupli-
cated, but the duplicated element is always saved in a personalised
library.
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Creating a hydraulic drawing
In addition to the hydraulic icons, further drawing elements (lines, rectangles, polygons, texts)
can be inserted and edited using the toolbar on the right.
Example: Rectangle
Once the rectangle has been inserted and „drawn“, you are in editor mode. Editor mode is rec-
ognisable by the shape of the cursor: 
An object which has already been inserted can be edited further by starting editor mode  in
the toolbar on the right and clicking the object.
The shape of the rectangle can be changed by dragging the marker points

If one of these marker points is dragged, rhombuses are created.
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The line type, colour and thickness, as well as the shape and fill colour can be changed by double 
clicking the rectangle in selection mode.
Example:

A global setting for these elements can be selected for all hydraulic drawings
via the menu item „Object/line and fill...“. These settings are retained, even if
the program is restarted.
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Example of a simple hydraulic drawing
As an example, the individual steps for creating a simple hydraulic drawing (solar thermal system)
are described below.
1. Place the hydraulic icons „Collector“, „Cylinder“, „Pump“ and „Check valve“ in the drawing area by 

dragging them from the search tree and aligning them on the grid.

2. Create the link lines between the pins as described under „Programming“.
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3. Optional: Edit the lines and areas (colour/line thickness) by double clicking the element or going 
to the Icon editor.

View after editing lines and hydraulic elements:

4. Adding sensors and designations

5. Finalise by saving 

Subject to technical modifications. © 2025 
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